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Grant Management System Quick Start Guide 
Introduction

Welcome to RPOSD’s Grant Management System (GMS) Quick Start Guide! 

This guide provides information on using the GMS to apply for, manage, and close Measure 
A grants. It contains the following sections:

1.  Introduction

2.  Registration

3.  Navigating the GMS

4.  Applying for Annual Allocation Grant Program Funds
•	 Overview
•	 Development Application Checklist
•	 Acquisition Application Checklist
•	 Planning & Design Application Checklist

5.  Applying for Competitive Grant Program Funds (not yet available)
•	 Overview
•	 Natural Lands, Local Beaches, Water Conservation & Protection Application
•	 Neighborhood Parks, Healthy Communities, & Urban Greening Application
•	 Acquisition-Only Application
•	 Recreation Access Application
•	 Youth & Veteran Job Training & Placement Application

6.  Applying for Other Funds
•	 Maintenance and Servicing
•	 Innovation Grants

7.  Managing Your Grants (not yet available)

8. Closing Your Grants (not yet available)
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Grant Management System Quick Start Guide 
Introduction, cont’d

What is the Grant Management System (GMS)?

The Grant Management System (GMS) is the online Webgrants grant management system 
RPOSD uses to accept applications for Measure A Grant Funds, manage those grants, and 
close completed grants. The GMS creates a permanent digital record of all grant applications, 
grant administration records, and grant closing documents. The GMS is also used to facilitate 
communication between applicants/grantees and RPOSD’s Grants Officers.

Why Use the GMS?

The GMS streamlines the grant application, administration, and closing processes through 
the use of digital records and communications. The GMS ensures that records and 
communications are maintained in a manner that facilitates access and ease of use. The 
GMS also includes mechanisms designed to help RPOSD comply with Measure A’s reporting 
requirements. All applicants and grantees are required to use the GMS to apply for, manage, 
and close Measure A grants.

What if I Need Help Using the GMS?

This Quick Start Guide is designed to assist you in using the GMS. If you can’t find the 
answers you need here, RPOSD is ready to assist you! Give us a call at 626.588.5060 
Monday-Thursday or send us an email at info@rposd.lacounty.gov



Grant Management System
Quick Start Guide
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Registration

This section provides instructions for completing the GMS registration process. 

Why Should I Register?

Registration is a required step for any public agency, nonprofit organization, or school 
applying for a Measure A grant. Registering now ensures that your agency or organization 
will by ready when it’s time to apply for Measure A grants.

Who Should Register?

All eligible public agencies, joint-powers authorities, nonprofit organizations, and schools 
should register.  Refer to the Measure A Eligibility Requirements on page 19 of this guide to 
determine if your agency or organization is eligible to receive Measure A funds.

Initial registration should be completed by a single individual within your agency or 
organization. This individual should have access to, and knowledge of, general information 
about your agency’s/organization’s operations.

If registration is completed by more than one individual, the additional registrations will be 
discarded by the system.  Avoid doing double work by making sure everyone in your agency/
organization is aware that registration will be completed by a single individual. 

You will add additional users once your initial registration is complete. 

How Long Will this Take?

Testing of the registration process shows that most people complete the process in 15 to 30 
minutes. To ensure a smooth registration, use the checklist on page 6 to make sure you have 
all required information and documents before starting.  

Once you submit your information, you will receive a confirmation email within 72 hours 
notifying you that your registration is active. Please add rposd@webgrantsmail.com to your 
safe senders list to ensure delivery to your inbox.

What if I Need Help?

RPOSD is ready to assist you! Give us a call at 626.588.5060 Monday-Thursday or send us 
an email at info@rposd.lacounty.gov
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Checklist: What Do I Need to Register?

Use this checklist to ensure that you have all required resources before 
initiating the registration process.  Each item is explained in more detail on 
the following pages.

All agencies/organizations will need the following information/documents  
to complete the registration process:

�� Contact Information 

�� Federal Tax ID Number

�� LA County Vendor ID Information

�� County of Los Angeles Vendor Direct Deposit Program Enrollment Status 

�� RPOSD Grant Terms

�� Technical Assistance Needs

�� Audited Financial Statement 

�� Proof of Jurisdiction Support (if available)

Public agencies will also need:

�� Annual Allocation Plan

Nonprofit organizations will also need:

�� Mission Statement 

�� Articles of Incorporation

�� Proof of 501(c)3 Status

�� IRS Form 990

Schools do not need any additional items.
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Getting Started

Note: Before proceeding with the registration process, all agencies and 
organizations are encouraged to carefully review the Measure A Eligibility 
Requirements on page 19 of this guide to determine if your agency/
organization is eligible to receive Measure A funds. 

Contact RPOSD at 626.588.5060 or info@rposd.lacounty.gov with any 
questions about eligibility.

You will need a compatible computer, tablet, or smart phone with internet 
access complete the registration process:

Operating System. RPOSD’s grant management system is compatible with the following 
operating systems:

Browser. The grant management system is compatible with the following browsers: 

If you do not have access to a computer, tablet, or smart phone that is compatible with the grant 
management system, you are invited to complete the registration process at RPOSD’s office in 
Alhambra. Contact RPOSD at 626.588.5060 for additional information.  
 
If you’re not able to visit RPOSD’s office, many public libraries and community centers have 
computer facilities that can be used to access the system, as it is web-based.  
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NOTE: Data you enter in the system is only saved when you complete all 
required fields and select “Register.” Any data you enter will be lost if you 
are not able to complete the process in one session. Be sure you have all 
required resources available before starting the registration process, and set 
aside at least 30 minutes to complete the process.

RPOSD cannot restore any data that is lost if you are not able to complete 
the process in one session. 

Step 1: Access the RPOSD Webgrants Online System

•	 Navigate to https://grantfunding.rposd.lacounty.gov/ You may want to bookmark this 
page, as you will be returning to it frequently in the future.

•	 The “Announcements” portion of the page contains important information and will be 
updated regularly.  Please be sure to read the announcements each time you visit this 
page.

•	 Click on the “Register Here” link to begin. 
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Step 2: Personal Information

Supply the requested personal contact information. 

•	 Throughout the registration process, all fields with a red asterisk (
*
) require a response 

from you. Your registration cannot be submitted if theses fields are left blank.

•	 Use your work phone number, email, and address.

•	 If your agency or organization does not have departments, divisions, or sections, please 
enter “n/a” in the “Department Name” field.
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Step 3: Agency/Organization General Information

Supply the requested information about your agency/organization.

•	 “Agency/Organization Name” Enter the full legal name of your agency/organization here. 
For example, “City of South Pasadena” or “Community Nature Connection.”

•	 “Agency/Organization Type” Use the drop-down menu to select the category that best 
describes your agency/organization. Choose from “Public Agency,” “Nonprofit Organization,” 
“Joint Powers Authority,” or “Other.” 

•	 “Agency/Organization Website” Provide the address of the homepage. If your agency/
organization is very large or has many departments, you may provide the web address of 
the department that is responsible for Measure A grants.

•	 “Agency/Organization Phone” Provide the agency’s/organization’s main phone number 
here. If your agency/organization is very large or has many departments, you may provide 
the main number of the department that is responsible for Measure A grants. 

•	 Provide “Physical Address” and “Mailing Address” as requested. The mailing address 
will be used to send any necessary paper-based communications, with the exception of 
payments. Any payments issued by check will be sent to the address associated with the 
LA County Vendor ID number (refer to page 11 for additional information on Vendor ID).
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Step 4: Agency/Organization Financial Information

Supply the requested financial information

•	 “Tax ID” Supply your agency’s/organization’s Federal Tax ID number. If you do not have 
this number, your accounting department should be able to give it to you.

•	 “LA County Vendor ID” A vendor ID is required to receive payments from RPOSD. If you 
need to obtain a Vendor ID, you may select “No” to continue the registration process. A 
Grants Officer will follow up with you to make sure you have obtained a Vendor ID.  
 
Review information on file by visiting  
https://camisvr.co.la.ca.us/webven/VendLookup/VendSearch.asp   
Search by  Vendor Name or Vendor Number to find your agency/organization. Many public 
agencies and some nonprofit organizations have multiple Vendor IDs with Los Angeles 
County. You are strongly encouraged to verify the Vendor ID you will be using for Measure 
A payments by working with your accounting team or an RPOSD Grants Officer. 
 
If you find that you need to update the information on file, visit the Vendor Self Service 
Portal at https://camisvr.co.la.ca.us/webven/vss_portal_info.asp  
 
If your agency/organization does not have a Vendor ID, you can obtain one by visiting   
https://camisvr.co.la.ca.us/webven/LoginNew.asp

•	 “Direct Deposit” Direct Deposit is the County’s default form of payment, per Los Angeles 
County policy.  
 
Use the drop-down menu to select either “Enrolled in Direct Deposit” or “Will Enroll in 
Direct Deposit.”  Leave additional comments only if needed.   
 
If your agency/organization is not yet enrolled in Direct Deposit with the County, you can 
enroll by visiting https://directdeposit.lacounty.gov/ 
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Step 5: Information Required From All Agencies/Organizations

The information in this section is required of all registrants

•	 “Grant Agreement Terms” All registrants must review RPOSD’s grant agreement terms 
to determine their agency’s/organization’s ability to meet requirements and long term 
obligations. Reviewing these terms now ensures that grantees are able to quickly execute 
grant agreements when awarded a grant. You can download the grant agreement terms at:  
http://rposd.lacounty.gov/wp-content/uploads/2019/01/Grant-Agreement_Final.pdf

•	 “Technical Assistance” Use the menu to select the types of technical assistance that you 
would like to receive, if any.  Choose from “Not Requesting,” “Planning and Design Funds,” 
“Grant Writing,” “Professional Services/Consultants,” “Resources (toolkits, handbooks),” and/
or “Community Outreach Assistance.” Press CTRL+click to select more than one type of 
technical assistance. 
 
Indicating the type assistance in which you are interested does not guarantee services. 
If your technical assistance needs change in the future, you will have additional 
opportunities to report your needs.

•	 “How Did You Prepare for Registration?” Use the drop-down menu to indicate how you 
prepared for registration. Select from “Registered in person at RPOSD offices,” “Used the 
Quick Start Guide,” or “Viewed the webinar.”

•	 “Audited Financial Statement” Click on the “Choose File” button to upload a digital copy 
of your agency’s/organization’s most recent audited financial statement showing that 
financial statements are accurate and complete. For cities and other public agencies that 
file one, this will be the most recent Comprehensive Annual Financial Report (CAFR). 
Agencies with a large CAFR may choose to only uploaded the named sections.  
The name of the uploaded file will appear to the right of the “Choose File” button once 
the upload is complete. 

•	 “Proof of Jurisdiction Support” Use the drop-down menu to indicate the type of proof of 
authority your jurisdiction/board requires. Select from “My jurisdiction/board can provide a 
single resolution to accept all Measure A grants” or “My jurisdiction/board requires a resolution 
for every Measure A grant.” 
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Step 6: Public Agencies Only

The information in this section is only required of public agencies 

•	 “Annual Allocation Plan” Public agencies receiving annual allocations (“Community-Based 
Park Investment” and “Neighborhood Parks, Healthy Communities, and Urban Greening” 
funds) must report their plans for spending these funds. The allocations may be spent 
annually, or may be saved for a maximum of five years.  
 
Use the drop-down menu to select your anticipated spending timeline. Choose from 
“Will hold our annual allocations until litigation is resolved,” “Will spend some/all of our annual 
allocations in the next 12/24/36/48/60 months,” or “Has not yet identified a plan to spend 
annual allocations.” 
 
Provide additional information about your Annual Allocation Plan by copying and pasting 
it into the box or by clicking on “Choose File” to upload a digital copy of your plan. The 
name of the uploaded file will appear to the right of the “Choose File” button once the 
upload is complete.  See page 20 of this guide for an Annual Allocation Plan template. 

Step 6: Nonprofit Organizations Only

The information in this section is only required of nonprofit organizations

•	 “Mission Statement” Click on “Choose File” to upload your organization’s mission 
statement. The name of the uploaded file will appear to the right of the “Choose File” 
button once the upload is complete.

•	 “Articles of Incorporation” Click on “Choose File” to upload your organization’s articles of 
incorporation.

•	 “Proof of 501(c)3 Status” Click on “Choose File” to upload current proof of 501(c)3 status.

•	 “IRS Form 990” Click on “Choose File” to upload your most recent IRS 990 form.
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Step 7: Submit Information

Once you have provided all required information, select the blue “Register” button at the top 
or bottom of the page to submit your data.

•	 If any required information is missing, the system will alert you. Provide additional data if 

required, and select the blue “Register” button again to complete the process. 

•	 If your information is complete, you will see the following screen:

•	 You will receive an email from rposd@webgrantsmail.com letting you know that your 

registration has been received.

•	 Your registration will be activated within 72 hours. Once your registration is active you 
will receive two additional emails from rposd@webgrantsmail.com, one with your user ID 
and one with your password.  
 
These emails are generated by the system and you may receive the password before the 
user ID arrives. Please be patient.
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Step 8: Logging In

Once your registration is active and you have received your login information, return to the 
system homepage, https://grantfunding.rposd.lacounty.gov/ 

•	 Login with the User ID and Password you received via email.
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Step 9: Review Your Profile

•	 This is the main menu screen you’ll seen once you’ve logged in. Select “My Profile” to 
review your information.

•	 If any information is incorrect or missing, select the “Edit” button to make changes.

•	 If you’ve made changes, be sure to select “Save” before moving on to the next step.
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Step 10: Review Your Associated Organization

•	 Click on your “Associated Organization” to review your agency’s/organization’s 
information. 

•	 Review your agency’s/organization’s information. Select the “Edit” button to make any 
necessary changes. 

•	 If you’ve made changes, be sure to select “Save” before moving on to the next step.
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Step 11: Add Additional Users

•	 Scroll down the page to the “Registered Users” section. Invite additional users to join your 
agency/organization by selecting the “Add” button.

•	 Enter the requested contact information for the new user and select the “Save” button. 

•	 The new user will receive an email from rposd@webgrantsmail.com with instructions for 
logging in. 

•	 You are encouraged to add at least one additional user, and can add as many users as 
needed to help you manage your grants. You may return to this page and add users at any 
time.

You have now activated your registration. Thank you!

•	 RPOSD may contact you for additional information about the materials you submitted.

•	 Once your registration information has been verified by RPOSD Grants Officers, your 
registration will be complete. 

•	 You will receive notifications from rposd@webgrantsmail.com when funding 
opportunities are available.

•	 Funding opportunities will also be posted at RPOSD.LACounty.gov
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Measure A Eligibility

Eligibility requirements differ by agency/organization type. Consult the requirements below 
to determine if your agency/organization is eligible for Measure A funds:

Public Agencies:

•	 Any governmental agency, special district, or joint powers authority (JPA) that is 
authorized to acquire, develop, improve and restore real property for beach, wildlife, 
park, recreation, community, cultural, open space, water quality, flood control, or gang 
prevention and intervention purposes within Los Angeles County is eligible to apply for 
Measure A grants. 

Nonprofit Organizations:

•	 Eligible nonprofit organizations must have a mission related to one or more of the 
following focus areas: 

»» Environmental protection and preservation
»» Park, recreation, community services, or facilities
»» Gang prevention and intervention
»» Environmental education and interpretation
»» Tree planting
»» Conservation and preservation of wetlands or of lands predominantly  
in their natural, scenic, historical, forested, or open-space condition

»» Restoration of lands to a natural, scenic, historical, forested,  
or open space condition

»» Job skills training and educational opportunities to young adults and/or veterans

»» Nonprofit affordable housing development 

Schools

•	 Public and private nonprofit schools are eligible to enroll with RPOSD, provided they 
allow public use of school facilities during non-school hours or offer education/training 
programs. Schools offering education/training programs or certification placement 
services to youth and veterans are also eligible, and are limited to application applying for 
programmatic grants (e.g., Youth and Veteran Job Training and Placement Program and 
Recreation Access Program grants) only.  

Note: If you have any questions or concerns about your agency’s/
organization’s eligibility for Measure A Funds, contact RPOSD at 
626.588.5060 or info@rposd.lacounty.gov
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Annual Allocation Plan Instructions

•	 Public agencies receiving annual allocations (“Community-Based Park Investment” and 
“Neighborhood Parks, Healthy Communities, and Urban Greening” funds) must report 
their plans for spending these funds. 

•	 Annual allocation funds can be saved for a maximum of five years.

•	 The Annual Allocation Plan must include the information indicated below. If your agency 
is responsible for more than one Study Area, the Annual Allocation Plan must address all 
Study Areas.

•	 The following information is required in your Annual Allocation Plan: 

�� Name of Agency: NAME

�� Annual Allocation Plan for: YEAR

�� Study Area ID(s): NUMBER(s)

�� Our agency will spend: SOME/ALL of our annual allocations in the next NUMBER 
months. 

�� The funds will be expended on^:

1.  BRIEF PROJECT DESCRIPTION at PROJECT LOCATION.

2. BRIEF PROJECT DESCRIPTION at PROJECT LOCATION.

^If your agency plans to save funds, and does not yet have a plan, indicate “Unknown 
project at unknown location” 

Note: For information regarding the types of projects that can be supported 
with annual allocation funds, please consult the Grants Administration Manual 
for Measure A, which is available at:  
http://rposd.lacounty.gov/measure-a-grants-administration-manual/  
Select “Annual Allocations” and then click on the section you’re interested in.
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This section provides instructions for navigating the GMS. 

Why Should I Learn to Navigate the GMS?

All grant-related activities, from starting a new application, to continuing work on an 
in-progress application, to managing a grant that’s been awarded, will take place within 
the GMS. Regardless of what you need to accomplish in the GMS, you’ll use the basic 
navigation elements described below to complete your tasks. Familiarizing yourself with 
the organization of the GMS and the tools needed to use it will increase your efficiency and 
make applying for, managing, and closing your Measure A grants easier.

Who Should Learn to Navigate the GMS?

Any of your agency’s staff assisting you with the application, administration, or closing of 
grants will need to use the GMS and should learn how to navigate the system.  This will 
ensure that your staff is able to assist as needed during the grant application, administration, 
and closing processes.  

What if I Need Help?

This Quick Start Guide is designed to assist you in using the GMS. If you can’t find the 
answers you need here, RPOSD is ready to assist you! Give us a call at 626.588.5060 
Monday-Thursday or send us an email at info@rposd.lacounty.gov

Navigating the Grant Management System
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Navigating the Grant Management System

You must be registered with the GMS to access the system. Refer to page 5 for information 
about registering, and page 18 for information about adding additional users to the system once 
you’ve registered.

Logging In

You will need the User ID and Password issued to you by the system in order to log in. 

Using a compatible browser, navigate to the system homepage at  
https://grantfunding.rposd.lacounty.gov/ and enter your User ID and Password to log in. For 
information on system and browser compatibility, refer to page 7. 

Be sure to review the announcements on this page for updates from RPOSD, including 
information about funding opportunities, upcoming deadlines, new workshops, and other 
important information.

If you cannot remember your User ID or Password, try the following:

»» Search your inbox for an email from rposd@webgrantsmail.com that contains this 
information.

»» Click on the “Forgot User ID?” or “Forgot Password” links to retrieve this information

»» Contact RPOSD by email at info@rposd.lacounty.gov or by phone at 626.588.5060 to 
request this information.
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Navigating the Grant Management System

Main Menu

Once you log in, you will see the main menu of options available in the GMS, as shown in the 
image below:

Instructions. This link displays a high-level instructions page describing all the screens in the 
GMS. This detailed information will help your learn more about the GMS.

My Profile. This link contains contact information for you and the agency with which you 
are associated. You can add additional GMS users at this link, and update your own contact 
information as needed.  You can also reset your password here. 

Funding Opportunities. This link displays all currently posted opportunities for which your 
agency is eligible. Follow this link to create and submit applications for each opportunity.

My Applications.  This link connects you to all previously created applications associated with 
your account.

My Grants. This link displays all grants that have been awarded to your agency.  This is also 
where you will create status reports, complete reimbursement claims and communicate with 
RPOSD about your awarded grants.
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Navigating the Grant Management System

Menu Bar

Navigation in the system has been standardized where possible. The white menu bar at the top 
of page contains action buttons that you’ll use to navigate through the GMS. 

Will take you to the Main Menu page from any screen in the application.

Brings up an online help window that is specific to the page you are currently on. 
The Help window contains detailed information you will need to refer to as you 
complete your applications and manage your grants. It should be the first place you 
look when you need information.

Logs you out of the GMS and returns you to the Login page. Always log out of the 
system when you have completed your work.  The system will automatically log you 
out after two hours of inactivity.

These buttons are active only on some screens:

These buttons are active on all screens:

This button works similarly to the browser “back” button. Use this button to return 
to the previous screen, or to return to the main components page. If you are feeling 
lost at any time hit the Back button until you return to a familiar screen. You should 
use this button and not your browsers “back” button 

This button is active on screens that can be printed. Clicking this button will bring up 
a new window that will display the current screen’s contents in printer friendly black 
and white. To print the page go to File ->Print in the browser.

Available when new entries can be made. For example, use the add button to create 
a new Application, to add a new budget line item, or a new Task.

This button will delete items that you have created. Delete can be used to delete an 
Application or a Budget line item. Pressing delete will always result in a confirmation 
before the item is deleted. Use caution, as this action cannot be undone.

This button is available when the contents of the page you are on can be changed. 
For example, if you create a budget line item, you can edit it later with this link.

Available when you are creating or editing something. When you are finished, press 
the Save button to save your work and return to the previous screen. Save your 
progress often.
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Navigating the Grant Management System

Other Navigation and Action Buttons

Other buttons and links appear in the GMS in locations other than the top menu bar. These links 
will typically appear on the right hand side of the page sections below the menu bar and are 
specific to the page you are on. Their function is described in the page-level Help window on 
each page. 

NOTE: Data you enter in the system is only saved when you click on the “Save” 
button. If  you leave a page, log out, or are logged out by the system due to 
inactivity before clicking on the “Save” button, your data will be lost. 

RPOSD cannot restore lost data, so remember to always click the “Save” 
button as you work.
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This section provides instructions for applying for Measure A Annual Allocation Grant Funds.  
Measure A includes six Annual Allocation grant programs. Each Measure A program has varying 
requirements for eligibility and application.  Refer to the Measure A Basics Handbook and 
the Grants Administration Manual for Measure A (select the “Annual Allocation” section) for 
detailed information about the requirements of each program. 

Community-Based
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Healthy Communities, 

& Urban Greening

County Priority
Projects

County Cultural 
Facilities

Department of
Parks & Recreation

Department of
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Applying for Annual Allocation Grant Funds

Now that you understand the basics of navigating the GMS, review the section below to ensure 
you’re ready to apply for funds! 

Is My Agency Eligible?

Public Agencies, joint-powers authorities, nonprofit organizations, and schools may be eligible 
to receive Annual Allocations. Refer to the eligibility requirements in the  Measure A Basics 
Handbook and the Grants Administration Manual for Measure A (select “Eligibility and 
Registration Requirement” then click on Section 3.2) to confirm that your agency/organization is 
eligible to apply for Annual Allocation funds. 

Are Funds Available?

To understand the amount of funding available for your projects, please refer to the GMS home 
page to review your available funds. RPOSD Grants Officers can also verify the current balance 
of available funds.

How Long Will it Take to Apply?

Testing of the application process shows that most people complete the process in about 
two hours, not including the time needed to gather and prepare all required documents and 
information. 

Once you submit your application, you will receive a confirmation email notifying you that your 
application was received. RPOSD Grants Officers assigned to your agency will begin the review 
process and notify you on next steps accordingly

Please add rposd@webgrantsmail.com to your safe senders list to ensure delivery to your inbox.

What if I Need Help?

RPOSD is ready to assist you! Give us a call at 626.588.5060 Monday-Thursday or send us an 
email at info@rposd.lacounty.gov.

Note: You must be registered with the GMS to apply for funds. 

If you are not registered, or if you’re not sure if you’re registered, please contact 
RPOSD at info@rposd.lacounty.gov or by phone at 626.588.5060.  If anyone 
will be assisting you with the application process, be sure to add them to the 
system following the instructions on page 18. 
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Applying for Annual Allocation Grant Funds

Step One: Funding Opportunities

Your agency or organization can view current funding opportunities for which you are eligible 
by clicking on the Funding Opportunities section of the Main Menu.   

If more than one opportunity is available, you will need to determine which one to apply to. In 
general, all Measure A Annual Allocation grant programs have Development, Acquisition, and/
or Planning & Design funding opportunities. To determine which type of funding opportunity is 
best for your project, review the definitions below: 

Development Projects are identified capital projects that include construction, enhancement, or 
refurbishment of park or open space elements.

Acquisition Projects are identified capital projects that gains ownership or control of real 
property. Acquisition projects can also include subsequent clean-up and security activities of 
the acquired property. 

Planning & Design Projects are those projects that further the development of conceptual 
projects. Successful Planning and Design projects can help grantees apply for funding 
opportunities with RPOSD and other funding sources.

Once you’ve determined which Funding Opportunity you’ll be applying to, select it from the 
options available:  
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Once you’ve selected a funding opportunity, you will see additional information that is specific 
to that funding opportunity, including Details, Description, Attachments, and Web Links. 

»» Details include 
information about award 
amounts, due dates, and 
who the Program Officer 
is.

Note: This information is specific to each funding opportunity, so be sure to 
review it every time you apply for Measure A funds!

»» Description provides 
information about the 
funding opportunity, 
including links to 
detailed information 
about the grant program 
and eligibility for your 
reference.

»» Attachments are 
templates and resources 
that you can download 
and complete or refer 
to as required by the 
application. 

»» Web Links are provided for 
your reference as needed.



RPOSD Technical Assistance Program   •   GMS Quick Start Guide      35: Applying for Annual Allocations

Applying for Annual Allocation Grant Funds

Step Two: Gathering Information

To ensure a smooth application process, use the checklist that corresponds to the funding 
opportunity you’re apply for to make sure you have all required information and documents 
before starting. Checklists start on page 36. 

Step Three: Complete the Application

Once you have gathered all the information needed to complete the application, return to 
the funding opportunity and select “Start a New Application.” Once you’ve completed an 
application in the GMS, you will also have the choice to “Copy Existing Application,” which 
pre-populates many fields for you.

Select the application form you’d like to start with and begin entering the required information 
in the GMS.

Information is entered in the GMS in one of three ways:

»» Drop Down Menus offer a selection of responses to choose from. 

»» Free Form Fields allow you to type your response directly into the field.

»» File Uploads require that you upload a file to the GMS

Throughout the application process, all fields with a red asterisk (*) require a response from 
you. Your application cannot be submitted if any of these fields are left blank.
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Use this checklist to ensure that you have all resources required to complete the  
Annual Allocation - Development Application process.  Refer to the Help menu within the 
application for additional detail on each item. 

This application has nine required forms.

General Information Form:

�� Primary contact

�� Project title

�� Additional contacts

�� Organization

Acknowledgments Form:

�� Application workshop attendance: name, date, and type

Must review and acknowledge:

�� Good Standing Policy

�� RPOSD signage and branding requirements

�� Project delivery requirements

�� Insurance requirements

�� Deed restriction requirements

�� Grant agreement

Development Application Checklist

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Agency Information Form:

�� Agency type

�� Date that park inventory was last updated (public agencies only)

�� Authorized representative (must be a registered user of the GMS)

�� Authorized designee (must be a registered user of the GMS)

�� Simplified Organization Chart showing section responsible for grants

�� Proof of jurisdiction support

Grant Funding Form:

�� Agency type

�� Requested annual allocation amount

�� Study Area assigning funds (schools, non-profit, and joint-powers authorities only)

�� Acceptance or assignment of responsibility for long term obligations

�� Description of other funding sources (if applicable)

�� Jurisdiction Support from adjacent Study Area’s Agency of Record that gives them 
permission to apply for Measure A funds

�� Jurisdiction Support from adjacent Study Area’s Agency of Record that gives you, the 
applicant, authority to apply for and accept these funds on their behalf

�� Inclusion of funds from adjacent Study Areas
»» Adjacent Study Area name
»» Description of Study Area benefits for assigning community
»» Type of outreach and engagement
»» Outreach details including: meeting date, outreach methods. Attendance, and plans for 
future outreach.

»» Screen shots or link to social media outreach

»» Translated materials

Development Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Project Details Form:

�� Project Description 
»» Project title
»» Organization’s credibility/mission as it pertains to parks projects
»» Explanation of need for project
»» Anticipated measurable outcomes
»» Methods used to achieve desired outcomes
»» Project summary

�� Project Information
»» Type of development
»» Amenities to be developed
»» Joint/Shared Use Agreement (if applicable)

�� Project Location Information
»» Physical location
»» Location name

»» Assessor’s Identification Number

�� Planning and Design Information
»» Status of documents
»» Planning and Design documents (if applicable) 

�� Environmental Information
»» CEQA lead agency name
»» CEQA responsible agency name
»» CEQA type and status
»» Adverse site conditions
»» Mitigation plans

»» Agreement with Landowner (if applicable)

Development Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Project Details Form, cont’d:

�� Reporting Requirements
»» Supervisorial District
»» State Senate District
»» State Assembly District
»» U.S. Congressional District
»» Park ID
»» City/Council District (if applicable)

�� Maps and Reports
»» Project Vicinity Map
»» Site Plans
»» Grant Boundary Map

»» Explanation of any special provisions

Development Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Budget Form:

Identify the requested amounts in the following categories as applicable:

�� General soft costs

�� Consultant services

�� Environmental studies

�� Design costs

�� Contingency costs (hard and soft)

�� Plan check/permits

�� Site preparation

�� Notice to Proceed

�� Substantial completion

�� Final completion

�� Deed restriction recorded 

�� Final walk through

�� Grant closeout

Grant Timeline Form

Identify dates for the following milestones:

�� Preliminary site visit

�� Planning/design at 30% 

�� Planning/design at 100% 

�� Plan check/permits

�� Draft deed restrictions submitted

�� CEQA

�� Demolition costs

�� Construction/development costs

�� Artistic/signage elements

�� Sustainability

�� Project amenities

�� Hardscape

�� Softscape

Development Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Note: the Help button brings up a window with detailed information 
specific to the page you are currently on. Use the Help button for 
more information about any of the requirements of each form!

Community Outreach and Engagement Form

All items below must be provided for each occurrence of outreach/engagement

�� Documentation regarding language access requirements

�� Methods, dates, locations, and types of outreach and engagement conducted

�� Engagement outcomes including attendance, feedback, and next steps

�� Screen shot of online media outreach

�� Screen shot of post metrics

�� Translated materials

�� Meeting Sign-in sheets

�� Meeting photos (3)

�� Meeting materials/flyers

�� Meeting advertisements

�� Community feedback and comments

�� Additional supporting documents 

Site Photos Form:

�� Minimum of 3 site photos 

Development Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Use this checklist to ensure that you have all resources required to complete the  
Annual Allocation - Acquisition Application process.  Refer to the Help menu within the 
application for additional detail on each item. 

This application has ten required forms.

General Information Form:

�� Primary contact

�� Project title

�� Authorized official

�� Organization

Acknowledgments Form:

�� Application workshop attendance: name, date, and type

Must review and acknowledge:

�� Good Standing Policy

�� RPOSD signage and branding requirements

�� Project delivery requirements

�� Insurance requirements

�� Deed restriction requirements

�� Grant agreement

Agency Information Form:

�� Agency type

�� Date that park inventory was last updated (public agencies only)

Acquisition Application Checklist

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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�� Authorized representative (must be a registered user of the GMS)

�� Authorized designee (must be a registered user of the GMS)

�� Simplified Organization Chart showing section responsible for Grants

�� Proof of jurisdiction support

Grant Funding Form:

�� Agency type

�� Requested annual allocation amount

�� Study Area assigning funds (schools, non-profit, and joint-powers authorities only)

�� Acceptance or assignment of responsibility for long term obligations

�� Description of other funding sources (if applicable)

�� Jurisdiction Support from adjacent Study Area’s Agency of Record that gives them 
permission to apply for Measure A funds

�� Jurisdiction Support from adjacent Study Area’s Agency of Record that gives you, the 
applicant, authority to apply for and accept these funds on their behalf

�� Inclusion of funds from adjacent Study Areas
»» Adjacent Study Area name
»» Description of Study Area benefits for assigning community
»» Type of outreach and engagement
»» Outreach details including: meeting date, outreach methods. Attendance, and plans for 
future outreach.

»» Screen shots or link to social media outreach

»» Translated materials

Acquisition Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY



RPOSD Technical Assistance Program   •   GMS Quick Start Guide      44: Applying for Annual Allocations

Department of
Parks & Recreation

Department of
Beaches & Harbors

Applying for Annual Allocation Grant Funds 

Project Details Form:

�� Acquisition Description
»» Project title
»» Organization’s credibility/mission as it pertains to parks projects
»» Explanation of need for project
»» Anticipated measurable outcomes
»» Methods used to achieve desired outcomes
»» Acquisition summary

�� Acquisition Details
»» Eminent domain information (if applicable)
»» AIN
»» Acreage
»» Landowner
»» Anticipated date of acquisition
»» Parcel Map upload

�� Acquisition Maintenance
»» Long term obligation agency information
»» Information of agency responsible for maintenance of the acquisition

�� Environmental Information
»» CEQA lead agency name
»» CEQA responsible agency name
»» CEQA type and status
»» Adverse site conditions
»» Mitigation plans

Acquisition Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Project Details Form. cont’d:

�� Reporting Requirements
»» Supervisorial District
»» State Senate District
»» State Assembly District
»» U.S. Congressional District
»» Park ID
»» City/Council District (if applicable)

Grant Timeline Form:

Identify dates for the following milestones:

�� Preliminary site visit

�� Appraisal report

�� CEQA completion

�� Full executed purchase agreement

�� Escrow open

�� Relocation plan (if applicable)

�� Close of escrow

�� Grant deed (due within 30 days of closing escrow)

�� Recorded deed restriction (due within 30 days of closing escrow)

�� Grant closeout

Acquisition Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Budget Form:

Identify the requested amounts in the following categories as applicable:

�� Pre-acquisition soft costs

�� Appraisal

�� Preliminary title report

�� Estimated closing costs

�� Purchase price

�� Relocation costs

�� Title insurance

�� Signage

�� Environmental clean-up

�� Other funding sources (grant, private funding, etc)

Acquisition Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Note: the Help button brings up a window with detailed information 
specific to the page you are currently on. Use the Help button for 
more information about any of the requirements of each form!

Community Outreach and Engagement Form:

All items below must be provided for each occurrence of outreach/engagement

�� Documentation regarding language access requirements

�� Methods, dates, locations, and types of outreach and engagement conducted

�� Engagement outcomes including attendance, feedback, and next steps

�� Screen shot of online media outreach

�� Screen shot of post metrics

�� Translated materials

�� Meeting Sign-in sheets

�� Meeting photos (3)

�� Meeting materials/flyers

�� Meeting advertisements

�� Community feedback and comments

�� Additional supporting documents 

Site Photos Form:

�� Minimum of 3 site photos 

Acquisition Application Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Use this checklist to ensure that you have all resources required to complete the  
Annual Allocation - Planning and Design Application process.  Refer to the Help menu within 
the application for additional detail on each item. 

This application has nine required forms.

General Information Form:

�� Primary contact

�� Project title

�� Additional contacts

�� Organization

Acknowledgments Form:

�� Application workshop attendance: name, date, and type

Must review and acknowledge:

�� Good Standing Policy

�� RPOSD signage and branding requirements

�� Project delivery requirements

�� Insurance requirements

�� Review of Technical Assistance grants

�� Review of grant agreement

Planning & Design Checklist

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Planning & Design Checklist, cont’d

Agency Information Form:

�� Agency type

�� Authorized representative (must be a registered user of the GMS)

�� Authorized designee (must be a registered user of the GMS)

�� Simplified organization chart showing section responsible for grants

�� Proof of jurisdiction support

Project Details Form:

�� Project Description 
»» Project title
»» Organization’s credibility/mission as it pertains to parks projects
»» Explanation of need for project
»» Anticipated measurable outcomes
»» Methods used to achieve desired outcomes
»» Describe proposed sustainable elements of the project
»» Project summary

�� Project Type
»» Park Master Plan or Parks Master Systems Plan
»» Feasibility Studies
»» Environmental Planning/Compliance
»» Open Space and Recreation Element Updates
»» Community Outreach and Engagement
»» Other

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Planning & Design Checklist, cont’d

Project Details Form, cont’d:

�� Project Location Information

�� Reporting Requirements
»» Supervisorial District
»» State Senate District
»» State Assembly District
»» U.S. Congressional District
»» Park ID
»» City/Council District (if applicable)

�� Special Provisions

Grant Funding

�� Annual Allocation Request
»» Agency type

�� Adjacent Study Area Annual Allocation Funding

�� Other Funding Sources

Helpful Tip: Response fields on GMS often have word count limits. As 
notification of exceeding the count only happens when attempting to save or 
submit responses, we recommend drafting your answers on a program that 
can track word counts, such as Microsoft Word, first!

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Grant Timeline Form:

Identify dates for the following milestones:

�� Overall grant timeline
»» Project start date
»» Project completion
»» Grant closeout

�� Project specific timeline

Budget Form:

Identify the requested amounts in the following categories as applicable:

�� General requirements (soft costs)

�� Environmental studies (hard costs)

�� Consultant services (hard costs)

�� Design (hard costs)

�� Community engagement (hard costs)

�� Contingency (10% max.)

Site Photos

�� Minimum of 3 site photos, if applicable

Planning & Design Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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Community Outreach and Engagement

�� Project total cost

�� Language access requirements

�� Information sharing

�� Concurrent participatory engagement

�� Dedicated participatory engagement

Planning & Design Checklist, cont’d

County Cultural 
Facilities

Community-Based
Park Investment

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

County Priority
Projects

PRIO
RITY
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This section provides instructions for applying for Measure A Competitive Grant Funds.  
Measure A includes five competitive grant programs. Each Measure A program has varying 
requirements for eligibility and application.  Refer to the Measure A Basics Handbook and the 
Grants Administration Manual for Measure A (select the “Competitive Grants” section) for 
detailed information about the requirements of each program. 

Applying for Competitive Grant Program Funds

Note: Competitive Grant applications have firm deadlines. Refer to the Grants 
Administration Manual for Measure A (select “Measure A Grant Administration 
Overview” and then click on section 3.1.2 Competitive Grants) to understand 
when each grant program will offer funding opportunities. Contact RPOSD 
at info@rposd.lacounty.gov or by phone at 626.588.5060 if you need more 
information 

Natural Lands,
Local Beaches,

Water Conservation
& Protection

Neighborhood Parks, 
Healthy Communities, 

& Urban Greening

Youth & Veteran
Job Training
& Placement

Recreation 
Access

Competitive Grants 

Acquisition-Only
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Applying for Competitive Grant Program Funds

Now that you understand the basics of navigating the GMS, review the section below to ensure 
you’re ready to apply for funds! 

Is My Agency/Organization Eligible?

Public Agencies, joint-powers authorities, nonprofit organizations, and schools may be eligible 
to apply for competitive grant funds. Refer to the eligibility requirements for each competitive 
grant program in the Measure A Basics Handbook and the Grants Administration Manual 
for Measure A (select “Eligibility and Registration Requirement” then click on Section 3.2) to 
confirm that your agency/organization is eligible to apply for competitive grant funds. 

When Are Funds Available?

Competitive grant funds are available on different cycles, depending on the competitive grant 
program. Refer to the competitive grant calendar in the Grants Administration Guide for 
Measure A to see when each competitive grant program is offered. 

How Long Will it Take to Apply?

Testing of the application process shows that most people complete the process in about 
two hours, not including the time needed to gather and prepare all required documents and 
information. 

Once you submit your application, you will receive a confirmation email notifying you that your 
application was received. RPOSD Grants Officers assigned to your agency will notify you on 
next steps accordingly.

Please add rposd@webgrantsmail.com to your safe senders list to ensure delivery to your inbox.

What if I Need Help?

RPOSD is ready to assist you! Give us a call at 626.588.5060 Monday-Thursday or send us an 
email at info@rposd.lacounty.gov

Note: You must be registered with the GMS to apply for funds. If you are not 
registered, or if you’re not sure if you’re registered, please contact RPOSD at 
info@rposd.lacounty.gov or by phone at 626.588.5060.  If anyone will be 
assisting you with the application process, be sure to add them to the system 
following the instructions on page 18. 
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Step One: Funding Opportunities

Your agency or organization can view current funding opportunities for which you are eligible 
by clicking on the Funding Opportunities section of the Main Menu.   

If more than one opportunity is available, you will need to determine which one to apply to. 
Every Measure A competitive grant program funds distinct project types and has distinct 
application requirements. To determine which type of competitive grant funding opportunity 
is best for your project, review the descriptions of each program in the Measure A Basics 
Handbook and the Grants Administration Manual for Measure A (select “Competitive Grants”). 

Once you’ve determined which Funding Opportunity you’ll be applying to, select it from the 
options available:  
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Once you’ve selected a funding opportunity, you will see additional information that is specific 
to that funding opportunity, including Details, Description, Attachments, and Web Links. 

»» Details include 
information about award 
amounts, due dates, and 
who the Program Officer 
is.

Note: This information is specific to each funding opportunity, so be sure to 
review it every time you apply for Measure A funds!

»» Description provides 
information about the 
funding opportunity, 
including links to 
detailed information 
about the grant program 
and eligibility for your 
reference.

»» Attachments are 
templates and resources 
that you can download 
and complete or refer 
to as required by the 
application. 

»» Web Links are provided for 
your reference as needed.
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Applying for Competitive Grant Program Funds

Step Two: Gathering Information

To ensure a smooth application process, use the checklist that corresponds to the funding 
opportunity you’re apply for to make sure you have all required information and documents 
before starting. Checklists start on page 60. 

Step Three: Complete the Application

Once you have gathered all the information needed to complete the application, return to 
the funding opportunity and select “Start a New Application.” Once you’ve completed an 
application in the GMS, you will also have the choice to “Copy Existing Application,” which 
pre-populates many fields for you.

Select the application form you’d like to start with and begin entering the required information 
in the GMS.

Information is entered in the GMS in one of three ways:

»» Drop Down Menus offer a selection of responses to choose from. 

»» Free Form Fields allow you to type your response directly into the field. 

»» File Uploads require that you upload a file to the GMS

All fields with a red asterisk (*) require a response from you.
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Recreation Access Program Application Checklist

The Competitive Grant application for the Recreation Access Program has 8 required forms. 
Use this checklist to ensure that you have all resources required to complete the application 
process. Refer to the Help menu within the application for additional detail on each item. A 
response for all questions is required. If a question does not apply to your program, please 
explicity respond with “Not Applicable” or an explanation. Blank responses will result in an 
incomplete application during Administrative Review and will not qualify for Evaluation and 
funding.

General Information Form:

�� Primary contact

�� Project title

�� Additional contacts

�� Organization name

Acknowledgments Form:

�� Application workshop attendance: name, date, and type

Must review and acknowledge:

�� Good Standing Policy

�� Eligibility Requirements

�� RPOSD signage and branding requirements

�� Multi-Year Funding and Evaluation requirements

�� Project delivery requirements

�� Insurance requirements

�� Grant agreement

Reminder: At the beginning of each 
form, there is an Instructions section. 
Carefully read these instructions prior 
to filling out the rest of the form to 
take note on how to edit each section!
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Recreation Access Program Application Checklist, cont’d

Agency Information Form:

�� Agency type

�� Authorized representative (must be a registered user of the GMS)

�� Authorized designee (must be a registered user of the GMS)

�� Simplified organization chart showing section responsible for grants

�� Proof of jurisdiction support

Program Details Form:

General:

�� Program Description

�� Program Summary

�� Participant Outreach Plan Description

�� Accessibility and Connectivity to Recreational Activities/Sites 

�� Mission Statement

�� Third-Party Evaluation Plan

Program Elements:

�� Expected Outcomes and Impact

�� Safety and Transportation Elements

�� Accomodations for Diverse Needs

Organization/Financial Health:

�� Description of Overall Operations

�� Current fiscal year operating budget/audit

�� Future Funding

Note: the Help button, located on the 
upper left corner of the page, brings 
up a window with detailed information 
specific to the page you are currently 
on. Use the Help button for more infor-
mation about any of the requirements 
of each form!
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Reporting Requirements:

�� Study Area(s)

�� Supervisorial District

�� State Senate District

�� State Assembly District

�� U.S. Congressional District

�� City / Council District

�� Any additional location(s) covered under program transportation

Additional Program Details Form:

Staff

�� Name, Title, Role, and Biography/Hiring Plan

Volunteers

�� Number, Role/Responsibilities, Experience Years/Level

Maps

�� All map(s) applicable to the program

Outreach & Engagement

�� Identify lead and outreach type if program includes a capital project

�� Describe outreach performed and intended audience

�� Describe method used and success of outreach efforts

�� Describe outreach purpose and identify engagement goals

Additional Documents

�� Upload any additional documents to support your program

Recreation Access Program Application Checklist, cont’d

Helpful Tip: Response fields on GMS 
often have word count limits. As 
notification of exceeding the count 
only happens when attempting 
to save or submit responses, we 
recommend drafting your answers on 
a program that can track word counts, 
such as Microsoft Word, first!
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Budget Form:

Identify the tasks, start & end dates, requested RPOSD funding amount, other funding 
amount, total funding amount, and deliverables in the following categories as applicable:

�� Program Development

�� Program Year 1

�� Program Year 2

�� Program Evaluation and Closeout

Program Partnership Form:

�� Partnership Identification(s) and Description(s)

�� Supporting documentation

Metro Supplemental Form:
This form only exist in the Recreation Access Competitive Grant Program Application to be forwarded Metro for final 
determination of Metro’s Measure M funding and/or in-kind award of selected program(s):

�� Description of Transportation Service or Infrastructure

�� Supportive Programs and Initiatives Strategy Proposal
»» Discuss wayfinding and communication strategies, include location(s), benefit(s), transit 
connection(s) and funding approch(es)

»» Describe how the program incorporate user friendly services and infrastructure
»» Discuss any integrated educational or interpretive programming
»» Describe how the program will be sustained beyond the grant period

�� Description of Community-to-Park Connections

�� Map that identifies the community of interest 

�� Map that identifies the park(s) accesssed by the program 

Recreation Access Program Application Checklist, cont’d
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Youth & Veteran Job Training & Placement Program Application Checklist

The Competitive Grant application for the Youth & Veteran Job Training & Placement Program 
has 7 required forms. Use this checklist to ensure that you have all resources required to 
complete the application process. Refer to the Help menu within the application for additional 
detail on each item. A response for all questions is required. If a question does not apply to 
your program, please explicity respond with “Not Applicable” or an explanation. Blank responses 
will result in an incomplete application during Administrative Review and will not qualify for 
Evaluation and funding.

General Information Form:

�� Primary contact

�� Project title

�� Additional contacts

�� Organization name

Acknowledgments Form:

�� Application workshop attendance: name, date, and type

Must review and acknowledge:

�� Good Standing Policy

�� Eligibility Requirements

�� RPOSD signage and branding requirements

�� Multi-Year Funding and Evaluation requirements

�� Project delivery requirements

�� Insurance requirements

�� Grant agreement

Reminder: At the beginning of each 
form, there is an Instructions section. 
Carefully read these instructions prior 
to filling out the rest of the form to 
take note on how to edit each section!
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Note: the Help button, located 
on the upper left corner of the 
page, brings up a window with 
detailed information specific to 
the page you are currently on. 
Use the Help button for more 
information about any of the 
requirements of each form!

Youth & Veteran Job Training &Placement Program Application Checklist, 
cont’d

Agency Information Form:

�� Agency type

�� Authorized representative (must be a registered user of the GMS)

�� Authorized designee (must be a registered user of the GMS)

�� Simplified organization chart showing section responsible for grants

�� Proof of jurisdiction support

Program Details Form:

General:

�� Program Description

�� Program Summary

�� Participant Outreach Plan Description

�� Career Preparation in Conservation, Parks, and Recreation Fields 

�� Mission Statement

�� Third-Party Evaluation Plan

Program Elements:

�� Expected Outcomes and Impact

�� Safety and Transportation Elements

�� Accomodations for Diverse Needs

Organization/Financial Health:
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�� Description of Overall Operations

�� Current fiscal year operating budget/audit

�� Future Funding

Reporting Requirements:

�� Study Area(s)

�� Supervisorial District

�� State Senate District

�� State Assembly District

�� U.S. Congressional District

�� City / Council District

�� Any additional location(s) covered under program transportation

Additional Program Details Form:

Staff

�� Name, Title, Role, and Biography/Hiring Plan

Volunteers

�� Number, Role/Responsibilities, Experience Years/Level

Maps

�� All map(s) applicable to the program

Outreach & Engagement

�� Identify lead and outreach type if program includes a capital project

�� Describe outreach performed and intended audience

�� Describe method used and success of outreach efforts

Youth & Veteran Job Training &Placement Program Application Checklist, 
cont’d
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�� Describe outreach purpose and identify engagement goals

Additional Documents

�� Upload any additional documents to support your program

Budget Form:

Identify the tasks, start & end dates, requested RPOSD funding amount, other funding 
amount, total funding amount, and deliverables in the following categories as applicable:

�� Program Development

�� Program Year 1

�� Program Year 2

�� Program Year 3 

�� Program Evaluation and Closeout

Program Partnership Form:

�� Partnership Identification(s) and Description(s)

�� Supporting documentation

Youth & Veteran Job Training &Placement Program Application Checklist, 
cont’d

Helpful Tip: Response fields on GMS often have word count limits. As 
notification of exceeding the count only happens when attempting to save or 
submit responses, we recommend drafting your answers on a program that 
can track word counts, such as Microsoft Word, first!
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Applying for Competitive Grant Funds 

The Competitive Grant applications for the Natural Lands, Local Beaches, Water Conservation 
& Protection, Neighborhood Parks Program, Healthy Communities, & Urban Cleaning 
Program, and the Acquisition-Only Program will be available in the future.

Application Checklist
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Applying for Competitive Grant Funds 
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This section provides instructions for applying for other Measure A program funds, including 
Maintenance & Servicing Funds and Innovation Grant funds. Refer to the Measure A Basics 
Handbook and the Grants Administration Manual for Measure A for detailed information about 
the requirements of each program. 

Applying for Other Program Funds

Maintenance
& Servicing

Other Programs:

Innovation
Grants
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Applying for Other Program Funds

Now that you understand the basics of navigating the GMS, review the section below to ensure 
you’re ready to apply for funds! 

Is My Agency/Organization Eligible?

Public Agencies, joint-powers authorities, nonprofit organizations, and schools may be eligible 
to apply for other program funds. Refer to the eligibility requirements for each program in 
the Measure A Basics Handbook or the Grants Administration Guide for Measure A (select 
“Eligibility and Registration Requirement” then click on Section 3.2) to confirm that your agency/
organization is eligible to apply. 

When Are Funds Available?

Other program funds are available at intervals specific to each program. Refer to the Grants 
Administration Guide for Measure A to see when each program is offered. 

How Long Will it Take to Apply?

Testing of the application process shows that most people complete the process in about 
two hours, not including the time needed to gather and prepare all required documents and 
information. 

Once you submit your application, you will receive a confirmation email notifying you that your 
application was received. The RPOSD Grants Officer assigned to your agency will notify you on 
next steps accordingly.

Please add rposd@webgrantsmail.com to your safe senders list to ensure delivery to your inbox.

What if I Need Help?

RPOSD is ready to assist you! Give us a call at 626.588.5060 Monday-Thursday or send us an 
email at info@rposd.lacounty.gov. 

Note: You must be registered with the GMS to apply for funds. If you are not 
registered, or if you’re not sure if you’re registered, please contact RPOSD at 
info@rposd.lacounty.gov or by phone at 626.588.5060.  If anyone will be 
assisting you with the application process, be sure to add them to the system 
following the instructions on page 18. 
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Applying for Other Program Funds

Step One: Funding Opportunities

Your agency or organization can view current funding opportunities for which you are eligible 
by clicking on the Funding Opportunities section of the Main Menu.   

If more than one opportunity is available, you will need to determine which one to apply 
to. Every Measure A grant program funds distinct project types and has distinct application 
requirements. To determine which type of grant funding is best for your project, review 
the descriptions of each program in the Measure A Basics Handbook and the Grants 
Administration Manual for Measure A. 

Once you’ve determined which Funding Opportunity you’ll be applying to, select it from the 
options available:  



RPOSD Technical Assistance Program   •   GMS Quick Start Guide      76: Applying for Other Funds

Applying for Other Program Funds

Once you’ve selected a funding opportunity, you will see additional information that is specific 
to that funding opportunity, including Details, Description, Attachments, and Web Links. 

»» Details include 
information about award 
amounts, due dates, and 
who the Program Officer 
is.

Note: This information is specific to each funding opportunity, so be sure to 
review it every time you apply for Measure A funds!

»» Description provides 
information about the 
funding opportunity, 
including links to 
detailed information 
about the grant program 
and eligibility for your 
reference.

»» Attachments are 
templates and resources 
that you can download 
and complete or refer 
to as required by the 
application. 

»» Web Links are provided for 
your reference as needed.
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Applying for Other Program Funds

Step Two: Gathering Information

To ensure a smooth application process, use the checklist that corresponds to the funding 
opportunity you’re apply for to make sure you have all required information and documents 
before starting. Checklists start on page 70. 

Step Three: Complete the Application

Once you have gathered all the information needed to complete the application, return to 
the funding opportunity and select “Start a New Application.” Once you’ve completed an 
application in the GMS, you will also have the choice to “Copy Existing Application,” which 
pre-populates many fields for you.

Select the application form you’d like to start with and begin entering the required information 
in the GMS.

Information is entered in the GMS in one of three ways:

»» Drop Down Menus offer a selection of responses to choose from. 

»» Free Form Fields allow you to type your response directly into the field.

»» File Uploads require that you upload a file to the GMS

Throughout the application process, all fields with a red asterisk (*) require a response from 
you. Your application cannot be submitted if any of these fields are left blank.
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Applying for  

Use this checklist to ensure that you have all resources required to complete the  
Maintenance & Servicing Application process.  Refer to the Help menu within the application 
for additional detail on each item. 

This application has 3 required forms.

General Information Form:

�� Primary contact

�� Project title

�� Additional contacts

�� Organization

Budget:

�� Maintenance and Servicing Costs

»» Prior to project completion

»» After project completion

�� Reimbursable

�� Non-reimbursable

�� Revenue

�� Net reimbursable

�� Extraordinary costs

�� Supporting documents

Maintenance & Servicing Funds

Maintenance & Servicing
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Applying for  

Maintenance and Servicing Funds:

�� Maintenance and Servicing Acknowledgments

»» Good Standing

»» Maintenance and Servicing Procedures

�� Authorized signers

�� Project location/information

�� Receipt of funds

Maintenance & Servicing Funds, cont’d

Maintenance & Servicing
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Applying for  

Use this checklist to ensure that you have all resources required to complete the  
Innovation Grant Funds Application process.  Refer to the Help menu within the application for 
additional detail on each item. 

This application has XX required forms.

General Information Form:

�� Primary contact

�� Project title

�� Additional contacts

�� Organization

Innovation Grant Funds

Innovation Grants
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Applying for  

Innovation Grant Funds, cont’d

Innovation Grants
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